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1 
1. Introduction 
The program MATTEROKING 2.0 is designed to estimate 
the average number of  discontinuities on digitized topographic 
relief. This software is used for potential rock slope instabilities 
detection.  

T heory will not be developed in detail here, it can be found elsewhere in 
articles (Jaboyedoff et al., 1996; Rouiller et al., 1997; Jaboyedoff et al., 
1999, Baillifard et al., 2001).  

Using digital elevation model (DTM), the program Matterocking permits to 
compare structural data with topographic surface orientation in order to estimate 
the average number of discontinuities intersecting a topographic relief. Locations 
where rock-instabilities can occur by discontinuities or wedges that allow sliding 
can be spotted. Different functions are implemented such as estimates of potential 
sliding areas, surface number, and linear number of discontinuities within cell of 
the DTM.  

Matterocking is designed to calculate and not to generate graphic outputs. 
Nevertheless, some visualization utilities exist to have a quick view of the results.  
The file format are chosen in order to be used in to standard visualization program: 
Surfer Golden software© and ArcView ESRI©. 

Installation 
The program available on the WEB (www.crealp.ch) was compiled under 
Windows 98, in order to avoid problems of installation.  

To install, click on install program, the installation will update or not the requested 
Microsoft system files for running Visual Basic 6.0 applications, and add the 
requested DLL and OCX.  

http://www.crealp.ch/
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File format 
The input and output files are rectangular (only surfer files) or squared grid text 
files. Two file formats are proposed: 

¾ The grid format (*.GRD), which is the standard ASCII file format of 
Surfer 6.0. 

¾ The grid format (*.ASC), which corresponds to the ArcView 3.x ASCII file 
import format. 

A third file is proposed for export with coordinates, which can be read from excel. 
The no data value of both files type can be changed. The separator for the grid files 
can be either “;” or tabulators or spaces.  

Two examples of DTM files are distributed with the program TOPOSW.ASC and 
TOPOSW.GRD. 

The GRD files 

The ASCII Surfer file format contains an alphanumeric header DSAA in the first 
line. The second line contains the number of columns (Nx), and the number of 
lines (Ny). Note that the order of the rows of the file is inversed compared to the 
screen display (Fig. 1.1). 

The next three lines must contain X ,Y and Z limits (Xmin Xmax, Ymin Ymax, 
Zmin Zmax) respectively. The Grid mesh size can be different in x or y direction. 
The following lines are Ny rows of Nx data; the rows can be also cut in-between 
data values.  

The default value is the standard Surfer 6 default value 1.70141e+038. Separators 
can be tabulators, spaces, comas, and semicolons. Note that surfer format does not 
open a file with number of rows and columns containing a period (reel number 
value).  

 

DSAA 
Nx Ny 
Xmin Xmax 
Ymin Ymax 
Zmin Zmax 
Value(1,1)  Value(1,2)  … 
Value(2,1)  Value(2,2)  … 
…  …  … 

DSAA 
3 3 
0 1500 
1000 2500 
136 1850  
200 500 136 
510 1525 1850 
315 528 1243 

Figure 1.1 Description of the 3.GRD file format with an example of a 3 × 3 grid file (header in bold). 
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The ASC files 

 

ncols Nx 
nrows Ny 
xllcorner Xmin - Delta/2 
yllcorner Ymin - Delta/2 
cellsize Delta 
NODATA_value  Dodat 
Value(Nx,1)  Value(Nx,2)  … 
Value(Nx-1,1)  Value(Nx-1,2)  … 
…  …  … 

Ncols 3 
nrows 3 
xllcorner -375 
yllcorner 625 
cellsize 750 
NODATA_value  -9999 
315 528 1243 
510 1525 1850 
200  500 136 

  

Figure 1.2  Description of the 3.ASC file format with an example of a 3 × 3 grid file (header in bold). Same file as 
in figure 1.1, observe the inverse position of rows. 

The ASCII ArcView grid file is slightly different from the Surfer one, it is 
necessarily a squared grid. The headers must be displayed in lines with identifier 
indicating each header value (ncols, nrows, xllcorner, yllcorner, cellsize, 
NODATA_value). As in Surfer file the number of columns ncols (Nx) and rows 
nrows (Ny) must be specified. The grid position is described by the lower left corner 
x-y coordinates xllcorner and yllcorner and the cell size cellsize (Delta). Note that the lower 
corner of the ASC file does not correspond to the lower corner of the GRD files, because the first 
one uses a point as a pixel and the second uses point as mesh. Thus the ASC lower comer is 
shifted by a half-cell size down and left. The no data value NODATA_value is optional 
(Nodat), if it is not indicated, the default value –9999 is used by the program. 

The program Matteroking reads ASC file only if each header is on its own line. 
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2 
2. The windows and their use 
General functionalities of  the program are described in this chapter.  

The program Matterocking displays 5 types of windows, each one has a specific 
functionality. Most of the menus are similar, except for the window of treatments 
(Fig. 2.1).  

The grid files can be either treated, saved in other formats, edited numerically, 
viewed graphically; part of them can be extracted. The history of actions, which 
have led to file saving is stored in a file REPORT.TXT. 

Figure 2.1 Main window of the program, containing the five types of windows.  

The windows for treatment load data from file for the numerical treatment 
performed by Matterocking, and allows also to export file in other formats. It 
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displays the characteristics of the grid. The specific menus of this window are the 
treatment and exports. 

The files can be edited and saved after modification in the numerical grid display. 
The files can be viewed in a graphic display, which indicates also the characteristics 
of the grids. A similar window permits to extract graphically or not a part of grid 
file.  

A report window contains all the actions that have led to a new file. This window 
cannot be closed. 

6 
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3 
3. What does Matterocking? 
The methods used in the program Matterocking are simply described in this 
chapter.  

How the DTM is used 
DTM are 3D grid points of elevation values z that are distant by Dx in x direction 
and Dy in y direction (Dx and Dy are necessarily equal for ASC files). A cell is 
limited by four points, corresponding to a facet of topography, defined by the three 
x-y-z coordinates for each point. It can be approximated by a plane (Fig 3.1). The 
lines joining the middle of the opposite side of the topographic cell define this 
plane.  

Matterocking used mostly the orientation of the facets to calculate the number of 
discontinuity by cells.  

Mesh
Dx

Grid nodes

E
le

va
tio

n

Simplified Topography = plane

Pole of

the plane

Mesh Dy

Figure 3.1 In yellow the approximation of a facet of DTM cell using a plane.  
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The estimation of the orientation that is the perpendicular to the topographic cell is 
estimated in the center of four points and leads to a shift of the output grid origin 
from X Æ (X + Dx/2) and Y Æ (Y + Dy/2). This procedure has the advantage 
of less smoothing slopes than the standard GIS methods, which usually use a 
rectangle which contains point distant by 2 Dx  and 2 Dy to estimate orientation of 
the topography. 

During computation the cells that contain one or more default value, is not taken 
into account because the orientation cannot be computed. The grid is blanked for 
such cells. 

Characterization of discontinuities 
Here the discontinuities are considered as planar structures with average isotropic 
dimensions. This means that they can be simulated on average as discs (Fig. 3.2 a).  

Matterocking compares the average geometrical characteristics of the 
discontinuities with DTM, thus average orientation (direction/dip), average spacing 
(L), average trace length (T) have to be defined (Fig. 3.2 b). T can be assumed as 
the average section of a disc with a plane of constant orientation.  

a 

b 

Figure 3.2 a) Illustration of the signification of the average trace length T compared to the diameter D of a disc.  b)T 
is the average section of the disc. The section of a discontinuity is represented by s = L × T 

8 
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Computation of slope and slope aspect 
Using the perpendicular of the topographic facet, the slope aspect (azimuth) is 
easily obtained, computing its direction in the plan x-y assuming that the normal to 
the plane rising towards the sky (and not under the topography). The values range 
from 0° to 360°.  

The slope is simply the angle between the perpendicular to the plane with the 
vertical, it ranges from 0° to 90°.  

Potential sliding zones 
To create rock instability by sliding, a discontinuity set must have a dip less steep 
than the topographic surface. The computation is simply to calculate that the 
steepest slope of the discontinuity set makes with the perpendicular to the 
topographic facet a smaller angle than 90° (Fig. 3.3). 

This test is performed for the entire grid leading to zones of potential sliding of 
value 1 and –1 for the not sliding points (the solution with –1 was chosen instead 
of no data value, because no variation occurs and thus Surfer can not contour 
unique value and no data value). 

Figure 3.3 (A) Example of stereonet of the possible direction of sliding (in green), taking into account the topographic 
orientation (in black). (B) Illustration of the potential sliding zone in section, the apparent density depends on the angle θ  
between topography and discontinuity.  

Average number of discontinuities counted in 
each topographic facet 
Assuming a topographic surface S perpendicular to a discontinuity set, the average 
number of discontinuities counted within the surface S is ns = S/(L × T), assuming 
that (L × T) is the section a discontinuity. Now if the angle between discontinuities 
and topographic facet is different from 90°, then the number of discontinuities is 

9 
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smaller because the apparent section is greater than (L × T), the apparent spacing 
Lapp increasing to L/sin θ, where θ is the angle between the perpendiculars to the 
discontinuity and the topographic surface (Fig. 3.4).   

This calculation is independent from the direction of dipping of the discontinuity.  

 

 Figure 3.4  Illustration of the average section of a discontinuity cutting a topographic facet. θ  is the angle the 
perpendicular to the discontinuity and the topographic facet (see ’Fig 3.3). Here the discontinuity orientation does not 
allow siding. 

Average number of wedges counted in each 
topographic facet 
Wedges are defined by two discontinuity sets. Assuming a continuous network of 
infinite discontinuities for the two sets spaced respectively  by L1 and L2, it draws 
on a surface perpendicular to the discontinuity sets a network made of 
parallelepipeds. The parallelepipeds are considered as the section of the wedges. 
The number of wedges in a surface S is given by nw = S / (L1 × L2 / sin α), where 
is the angle between the two sets.  

This value is increased if the line of intersection of the two sets is not perpendicular 
to the surface of topography (Fig 3.5 and 3.6). If β is the angle between the 
discontinuity intersection line and the pole of the surface of topography, the 
number of apparent wedges is given by: nw

app = S  × cos β / (L1 × L2 / sin α).  
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Figure 3.5 Illustration of on topographic facet of the meaning of a wedges section. Here the wedge orientation does not 
allow siding. Sapp corresponds to the apparent surface of the wedge on the facet of surface s.  

Figure 3.6  Stereonet corresponding to a wedge sliding. 

Average number of sectors 
The previous methods present a difference; the number of discontinuities is 
independent of the steepest slope of the discontinuities, thus it does not give any 
information about the direction of potential sliding compared to the topographic 
surface. On the contrary wedge is sensitive to the direction of sliding. The less 
wedges occur, the less probable is an instability.  

11 
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The same principle can be used assuming that the greatest slope of a discontinuity 
set is equivalent to the direction of the wedge and L × T equivalent to the section 
of the wedge, leading to sectors of discontinuity potentially involved in sliding. T 
can be changed to a smaller value than the trace length (Fig. 3.7). T can be chosen 
as rock instability expected dimension. The scale is relative.  

This procedure permits to obtain an image of the potential volume involved in 
sliding. 
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Figure 3.7  Using the section of a discontinuity perpendicular to the discontinuity grater slope, it can be a projection 
on the topographic facet, leading to the section of the apparent section of the discontinuity.  

Number of discontinuities based on apparent 
spacing 
The traces of discontinuity sets are parallel on a planar topographic facet. The 
apparent spacing is perpendicular to the two traces. The mean number of 
discontinuities can be calculated along this direction. On a facet of topography the 

12 
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maximum length l of a line parallel to the apparent spacing can be estimated.  The 
number of discontinuities that can be found on average is given by l/Lapp (Fig. 3.8).  

Figure 3.8  l corresponds to the longer length of facet parallel to the apparent spacing Lapp.  

Probabilities 

Assuming random distribution of discontinuity position, it is possible to calculate 
the probability P to find at least one discontinuity within a distance or a surface. 
This probability is simply given by P = 1-e –N, where N is the mean number of 
discontinuities found within a distance or a surface. 

This method can be applied by counting on several cells the number of 
discontinuity (surface). The application to each cell is not necessarily appropriate 
because the size of discontinuity can lead to trivial results.  

It makes sense to estimate probability of finding a discontinuity within a cell using 
spacing. 

Altitude difference. 
Within a cell of the DTM, the maximum height of a slope can be computed by 
using the maximum difference between two extreme points of the cells. This 
corresponds to a rough estimate of cliff height.  

 

13 
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4. The menus 

Common File menu 

Figure 4.1  Menu file and window of file treatment.  

Open file to treat opens and loads in memory a file to treat and activate the menu 
that allows the treatments. The windows opened display the characteristics of the 
file (Fig. 4.1).  

Figure 4.2 View file header window. 

Read header of file permits to read only the header of file, it gives the 
specification of a file (Fig. 4.2). Note that for ASC, no minimum and maximum 
values are displayed because they do not appear in the header.  

14 
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Close window closes the active window and Quit terminates the program 
Matterocking. 

Common Utility menu 

Figure 4.3 Common menu Utility. 

This menu contains five different functionalities, which leads to the opening of 
new windows or allowing the transformation of files.  

The Numeric grid edition grid menu opens a file in a grid format in a new 
window, containing the grid value.  

The Grid image view menu opens a file and displays in a two colors gradient 
image within a fixed size in a new window.  

The View actions of this session menu maximizes the report window.   

The Extract menu opens a window that allows extracting a part of a grid file.  

The Merge menu permits to merge grids that are contiguous.   

File to treat window menu 
The file loaded can be exported or treated several times.  

File exports 

The menu Above a threshold value proposes to save a new grid file that contains 
value above a threshold or cut off value chosen by the user and below which the 
grid data value is set to the current default value of the file (Fig. 4.4).  

The menu In an another format gives simply the possibility to save the current 
file in the same or another format.  

The menu Save as numeric grid with coordinates, saves the current file in a file 
containing line and column headers that indicate coordinates.  

 

15 
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Figure 4.4  Input form for the threshold value. 

Treatments default value option 

Figure 4.5 Different treatment menus. 

The treatment is the heart of the software (Fig. 4.5). It permits to compare 
topography and discontinuities geometrical characteristics.  

Figure 4.6 Form input for the different default values. 

The Default value option menu set the default values i.e. no data value (see file 
format paragraph) of the different file format (Fig. 4.6). Changes are stored in a file 
d_val.bin  in the application directory. Note that the changes are effective for all 
new opened files and for all next session up to the next changes. This file is 
automatically created if it does not exist. The original default value can be 
automatically introduced.  

16 
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Treatments 

All menus of treatments display a dialog box for saving the results. Depending on 
the treatment a dialog box asks for the geometrical characteristics of the 
discontinuity set.   

The first treatment simply saves a file of Slope and Slope aspect (azimuth) 
calculated from the active DTM file.  

Figure 4.7 Dialog input box for the orientation value of the discontinuity set. 

Poten ial sliding (yes/no) menu asks for an orientation of a discontinuity set. It 
creates a file containing the 1 and -1 corresponding respectively to the zones where 
the discontinuity can produce rockslides or not (Fig. 4.7).  

t

 Number of discontinuities (surface) menu creates a file that contains the 
average number of discontinuities per unit cells of the DTM, based on average 
surface of discontinuities. The azimuth, the dip, the average spacing and the trace 
length of the discontinuity set must be inputted (Fig. 4.8). The computation can be 
performed on the entire surface if the check box is checked or computed only 
within the surface in which potential sliding exists.  

Figure 4.8 Dialog input box for the computation or number of discontinuity per unit cell based on surface count. The 
check box permits to compute this value on the entire surface of the DTM. 

Number of discontinuities (spacing) menu creates a file that contains the 
average number of discontinuities per unit cell or the probability to find at least one 
discontinuity within the cell, this last option is set by checking the probability 
option. The azimuth, the dip and the trace length of the discontinuity set must be 
inputted (Fig. 4.9). Those values can also be computed either on the entire surface 
or in the potential sliding zone (default). 

17 
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Figure 4.9 Dialog input box for the computation or number of discontinuities per unit cell based on spacing count. 
The check box permits to compute this value on the entire surface of the DTM, if probability is check the probability to 
find at lest one discontinuity per unit cells is computed, the results range from 0 to 1.  

Number of sectors (surface) menu creates a file that contains the average 
number of discontinuity in the direction of its steepest slope per unit cells of the 
DTM, based on average surface of section of the discontinuity set. Inputs are 
identical to Number of discontinuities (surface) (Fig. 4.8). 

Number of wedges menu creates a file that contains the average number of 
wedges per unit cells of the DTM. The azimuths, the dips and the trace lengths of 
the two discontinuity sets must be inputted (Fig. 4.10). This value can be obtained 
on the entire surface by checking Compute on the entire surface.  

Figure 4.10  Dialog input box for the computation or number of wedges per unit cell based on surface count. The 
check box permits to compute this value on the entire surface of the DTM. Orientation and spacing must be specified for 
the two sets of discontinuities. 

The menu Altitude diff. simply creates a file of the greatest difference of altitude 
within a cell, computed for the limiting points.  

Alternate menu for edit numerical data window 
The numerical data are displayed in a grid, which can be modified and saved. The 
coordinates of each grid point are displayed on upper left corner of the window.  
The headers of the grid correspond to the column number and the row number as 
it appears on a map.  

The Edit menu permits to Copy (Ctrl + C) the current selection and paste it to the 
clipboard with tabulator separator, which is compatible with Excel.  

18 
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In the menu file Save saves the current file with the current modifications. The 
menu Save as permits to save the current state of the file as a new file in the one of 
the two available formats (Fig. 4.11). As in the File to treat window the menu Save 
as numeric grid with coordinates save the current file in a file containing line 
and column headers that indicate coordinates.  

 

Figure 4.11 Grid file edit window. The coordinates are displayed in the upper left corner; the input box is located on 
the top of the numerical view. The file menu with its three options of file saving is also dropped down. 

Image view of file 
The display of a file as image, by Grid image view displays in a two colors 
gradient image from red to yellow. Three supplementary menus are added. First in 
the File menu a Print low quality menu is added, which performed a screen 
dump of the active window.  The Edit menu permits to Copy file header and its 
location and performs also screen Copy of the image (Fig. 4.11).   

 
 

19 
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Directory: C:\_users\VB_file\MDIPR\test\40_30_nbs_01.GRD 
Grid: 40 (25) x 40 (25) 
X min-max:  636012.5 - 636987.5 
Y min-max:  112512.5 - 113487.5 
Z min-max:  .108269166391652 - 13.6680297347889 

Figure 4.11 Grid file image view copied from the Matterocking. The copy of the header is displayed below.  

The extract window 

Figure 4.12 Extract form file window with the graphic display. The blue area corresponds to the selected area. The 
coordinates are automatically updated while moving scroll bars.  

This window is similar to the image view of file with a supplementary menu Save 
selection which allows to save the selection made by a graphic utility and scrolls 
bars (Fig. 4.12). Before opening the window the program asks if the user wants to 
see data or if selection is performed without display of data (for big files). 

20 
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The merge function 

Figure 4.13 Illustration of the different possibility for merging files 1 an d 2. 

This menu asks for two files that have to be merged. The files have to be 
contiguous exactly; it means that the adjacent columns must have the same number 
of rows, and being distant from a Dx exactly. The same remark can be made for 
the contiguous rows; they must contain the same number of columns and must be 
distant from Dy exactly (Fig 4.13). 

Report Window 
The Report of the session window is always opened; it is impossible to close it (Fig. 
4.14). The file menu associated with report replaces de close function with 
Maximize and Minimize the report window.  

The Report utility menu gives the possibility to Emptied or View the entire file 
report in an independent text window to visualize and Save the total of the report 
file.  

Figure 4.14 Edit window of the complete report file. The sessions are indicated and the parameters used for 
computation of each outputted file are also indicated.  

21 
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